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About these release notes
These release notes provide a list of new features and other important last-minute 
information applicable to Matrox X.tools build 6157. This information 
supplements the Matrox RT.X100 Xtreme Installation and User Guide (May 1, 
2003).

The procedure for installing your Matrox RT.X100 Xtreme Pro is the same as 
described in the Matrox RT.X100 Xtreme Installation and User Guide. Additional 
information on installing Matrox RT.X100 Xtreme Pro is provided in these 
release notes.

Last-minute information
The Readme file is no longer installed with the software in the Matrox X.tools 
folder. Any important last-minute information and operational limitations are 
included in these Release Notes.

¦ Note To make sure that you have the latest available software (updates and 
Service Packs) for your Matrox RT.X100 Xtreme Pro system, check the Support 
section of our web site at www.matrox.com/video/support.

Matrox RT.X100 Xtreme Pro bundle
Matrox RT.X100 Xtreme Pro comes bundled with the Matrox RT.X hardware and 
Matrox X.tools software for use with your copy of Adobe Premiere Pro or Adobe 
Production Studio.

What’s new in this release of Matrox X.tools?
This release of Matrox X.tools provides support for Adobe Production Studio, 
and requires Adobe Premiere Pro 2.0 (it does not support earlier releases of 
Adobe Premiere Pro).

All features available with the previous release of Matrox X.tools are supported 
with this new release, with the exception of full WYSIWYG support for Adobe 
Encore DVD 2.0. WYSIWYG support is provided, however, for previewing 
when using Adobe Premiere Pro’s Export to DVD feature. WYSIWYG is also 
supported for Adobe Bridge.

Installing Matrox X.tools
To install this release of Matrox X.tools, you must first uninstall any previous 
release of Matrox X.tools software by choosing Start > All Programs > 
Matrox X.tools > Uninstall. You must also uninstall all Matrox Effect add-ons 
and other RT.X software (such as the WYSIWYG plug-ins). To do this, use Add 
or Remove Programs in Windows Control Panel. After uninstalling Matrox 
About these release notes
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Rec
X.tools, you must install Adobe Premiere Pro 2.0 as explained in your Adobe 
documentation prior to installing this release of Matrox X.tools. 

Recommended system requirements
The recommended system is an Intel Pentium 4 at 2.4 GHz, AMD Athlon 64, or 
faster. To avoid performance issues, you need at least 1 GB of system memory 
(RAM) to use Adobe Premiere Pro 2.0 with your Matrox RT.X100 Xtreme Pro 
system.

¦ Note To install Adobe Premiere Pro 2.0, you must have a computer with a 
CPU that supports Streaming SIMD Extensions 2 (SSE2), which includes Intel 
Pentium 4 and AMD Athlon 64 or later. For details on Adobe Premiere Pro’s 
recommended system requirements, see your Adobe documentation.

Storage considerations
Recent changes in storage device technology now allow alternate storage device 
configurations in addition to those documented in your Matrox RT.X100 Xtreme 
Installation and User Guide. For example, some serial ATA (SATA) drives are 
appropriate for use as the video drive and export drive. For more information on 
storage recommendations, and a list of devices we’ve found to be unsuitable for 
use with RT.X100 Xtreme Pro, see the RT.X Support section of our web site at 
www.matrox.com/video/support.

Tested and approved third-party programs
The following third-party programs have been tested and approved for use with 
the WYSIWYG feature of Matrox X.tools build 6157:

• Adobe After Effects (versions 6.0. 6.5, and 7.0)

• Adobe Encore DVD (versions 1.5 and 2.0)

¦ Note When using Adobe Encore DVD version 2.0, WYSIWYG is available 
for menus only.

• Adobe Photoshop (versions 7.01, CS, and CS2)

• discreet 3ds max (versions 5.5 and 6.0)

• NewTek LightWave 3D (version 7.5)

¦ Note Although the Matrox plug-ins should work well with earlier supported 
versions of the programs, you use these earlier versions with the Matrox plug-ins 
at your own risk. We recommend that you upgrade your third-party software to 
one of the tested and approved versions.
ommended system requirements
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Displaying warnings in Adobe Premiere Pro’s 
Events panel

Matrox RT.X100 Xtreme Pro uses Adobe Premiere Pro’s Events panel to issue 
certain warnings, such as when frames have been dropped during capture. To 
display the warning, either double-click the alert icon on Adobe Premiere Pro’s 
status bar, or choose Window > Events. For more information about using the 
Events panel, see your Adobe Premiere Pro documentation.

Using the “Always output to 1394” option
The following is a change to the “Selecting your DV-1394 settings” section of the 
“Defining Your Adobe Premiere Pro Settings” chapter of the Matrox RT.X100 
Xtreme Pro User Guide Supplement:

Under Timeline Playback, select Always output to 1394 if you want to output 
your Timeline over the 1394 interface to your DV-1394 device whenever you 
play back the Timeline. When this option is selected, you’ll be limited to the 
Preview realtime effects only XtremePreview mode (that is, this mode is 
selected, and you are not able to change it). If you clear the Always output to 
1394 option, your previously selected XtremePreview mode becomes active 
again. Segments that require rendering with Always output to 1394 selected 
will display as a “not yet rendered” (X) graphic when previewed through your 
DV-1394 device’s viewfinder. To preview a segment with all applied effects on 
your NTSC or PAL video monitor, you can render-scrub (ALT+scrub) the 
Timeline.

Using the Windows Media version 9 video 
codec with MediaExport

Although Matrox MediaExport supports the Windows Media version 9 video 
codec, all of the Windows Media standard encoding profiles use the Windows 
Media version 8 video codec. To use the version 9 video codec to encode your 
video, you can customize a standard encoding profile by selecting the version 9 
video codec from the Codec Options drop-down list. For more information, see 
“Modifying standard profile settings to create a customized profile” in the “Using 
Matrox MediaExport” chapter of your Matrox RT.X100 Xtreme Installation and 
User Guide.
Displaying warnings in Adobe Premiere Pro’s Events panel
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A no
A note about DVD capacities
When choosing a data rate to create MPEG files for DVD authoring, make sure 
that you take into account the actual storage capacity of your DVD disk. This is 
because of a difference in terminology used by DVD manufacturers and accepted 
computer conventions. For example, commercially available 4.7 G (4.7 billion 
bytes) blank DVD disks have an actual storage capacity of 4.38 GB.

A note about using Adobe Encore DVD 
When using the Matrox Realtime Export to Disk feature to export your Adobe 
Premiere Pro Timeline to an MPEG-2 IBP (.m2v) file for use with Adobe Encore 
DVD (version 1.5 or 2.0), you can choose to export your sequence markers as 
chapter points. If you do so, a file with the extension .xmpses with the chapter 
point information is created and saved in the same folder as your saved .m2v file. 
If you move or rename your .m2v file, make sure that you move or rename the 
.xmpses file accordingly.

The .xmpses file that is created when exporting a .m2v file also contains data that 
helps Encore DVD open .m2v files faster, and allows you to use the Edit Original 
command on the clip in Encore DVD. Therefore, when exporting an .m2v file 
from Premiere Pro, you may want to select Export sequence markers as 
chapter points even if you aren’t using sequence markers.

¡ Important In order for the chapter points to be available in Adobe Encore 
DVD version 2.0, you must fill in the chapter information for your sequence 
markers in Adobe Premiere Pro.

Fixes in this release of Matrox X.tools
The following are fixes provided in Matrox X.tools build 6157:

• Adobe Premiere Pro will no longer freeze when PF usage (as shown in 
Windows Task Manager) is greater than 1.0 GB. (Ref# 37785)

• Adobe Premiere Pro will no longer crash when you choose Matrox 
Realtime Export to Disk to export a clip from the Project panel. (Ref# 
38209)

• When creating a custom Matrox old movie effect, your effect will now play 
back correctly in the Preview Window on the Custom page. (Ref# 32297)

Operational limitations
The following are operational limitations for Matrox X.tools build 6157:

Installation and general operation
• To install Matrox X.tools, your system drive and boot (startup) drive must be 

the same to allow the Matrox X.tools Setup program to successfully modify 
te about DVD capacities
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your boot.ini file. If your system and boot drive are different, you can 
manually edit your boot.ini file. To do this, start Windows Control Panel, 
double-click the System icon, click the Advanced tab, click Settings 
under Startup and Recovery, and then click Edit. Make sure that the /3GB 
and USERVA=2500 switches are present in your boot.ini file on the line 
directly below [operating systems] as shown in the following example:

[operating systems]
multi(0)disk(0)partition(1)WINDOWS=�Microsoft Windows XP Professional� 
/noexecute=optin /fastdetect /3B USERVA=2500
If needed, add the /3GB and USERVA=2500 switches to the end of the line. 
(Ref# 40655)

• When installing Matrox X.tools, if you try to change the Destination 
Folder in the Choose Destination Location dialog box more than once, 
the X.tools Setup program may stop responding. If this happens, click 
Cancel, then choose Browse again. (Ref# 26783)

• Your Matrox RT.X100 Xtreme Pro system does not support the hibernation 
feature in Windows. If you try to put your computer into hibernation, a 
message will be displayed to warn you that the system hibernation has failed. 
(Ref# 26458)

• If you use Symantec’s Norton Utilities on your Matrox RT.X100 Xtreme Pro 
system, you may experience errors starting the RT.X menu. (Ref# 28988)

• If you receive an IKernel.exe application error message when installing or 
uninstalling Matrox X.tools, download the fix available in the Support 
Knowledgebase (document ID Q108020) on the InstallShield web site at 
http://support.installshield.com/kb/ (Ref# 29080)

• You may encounter installation problems if you try to install Matrox X.tools 
on a computer running the Japanese version of Microsoft Windows XP. As a 
workaround, log on to Windows XP using single-byte characters instead of 
double-byte characters. (Ref# 30017)

• The first time you start Premiere Pro after a fresh installation of Premiere 
Pro with Matrox X.tools, you may receive an error message that the 
Splash.avi file cannot be found. If you quit and then restart Premiere Pro, 
you will no longer receive this error message. (Ref# 31855) 

Adobe Premiere Pro and the Matrox realtime plug-in
• When using Adobe Premiere Pro’s Export to DVD feature to export a 

segment of the Timeline that contains a Matrox transition applied between 
video clips on the same track, the resulting exported video may be incorrect. 
As as workaround, do any of the following:

$ Export your clips from the Timeline to an .mv2 file using Matrox 
MediaExport (select the Ligos MPEG encoding format), then use this .m2v 
Operational limitations

http://support.installshield.com/kb/
http://support.installshield.com/kb/


6

Ope
file to create your DVD with a DVD authoring program, such as Adobe 
Encore DVD.

$ Export your clips from the Timeline to a Matrox .avi file, add this clip to a 
new sequence, and then export the sequence using Adobe Premiere Pro’s 
Export to DVD feature. (Ref# 39334)

• If you apply a Matrox effect to a clip that has a speed change, the video 
output may flicker when you play back the clip. As a workaround, add the 
clip to a separate sequence and apply the speed change to it, then add that 
sequence to your main sequence and apply the effect you want to it. (Ref# 
37448)

• When using Matrox Realtime Export to Disk to export PAL video to an 
.avi or .m2v file, you may notice a flickering line at the bottom of the image. 
As a workaround, add a black .avi file to the beginning of your sequence, 
scrub only on this .avi file for about two seconds, then include the black .avi 
file in your export. (Ref# 39180)

• The Matrox Realtime Export to Disk feature does not support DVD 
markers in Adobe Premiere Pro. You can, however, export your sequence 
markers as chapter points as explained in “A note about using Adobe Encore 
DVD” on page 4. (Ref# 39212)

• If you are using the Japanese version of Adobe Premiere Pro, the Save File 
dialog box may not appear when you stop a capture. You may also get errors 
when trying to render. To avoid these problems, select Start > Control 
Panel > Regional and Language Options and under Language for 
non-Unicode programs, select Japanese. (Ref# 38454 & 38417)

• If you import .tga files created using Adobe Photoshop 7.0 to your Premiere 
Pro Timeline, the alpha channel will not be visible. If you frequently create 
.tga files using Photoshop 7.0 to use on your Timeline, you may want to 
upgrade to a later version of Photoshop, or download the Targa plug-in 
available in the Support Knowledgebase on the Adobe web site at 
www.adobe.com. (Ref# 28630)

• If your video drive is nearly full, serious errors can occur in Premiere Pro 
when capturing or exporting. To avoid these errors, make sure you have 
adequate space on your A/V drive before starting a capture or export to file. 
As a reminder, one minute of DV data requires approximately 175 MB of 
storage. (Ref# 20609 & 29108)

• If you’re using a RAID controller that has a system monitoring utility, such 
as a Promise FastTrak66, you may notice some Timeline sluggishness or 
capture freezes in Adobe Premiere Pro. Please disable this system 
monitoring utility if it is active on the Windows taskbar.

• Matrox DV-1394 Device Control can be used when capturing or recording 
material over the 1394 interface, and also when capturing the analog input 
rational limitations
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from your DV-1394 device, such as the composite input. If you want to 
perform an analog capture that is not from your DV-1394 device (such as to 
capture from a composite or S-Video deck), make sure you set Device 
Control to None by choosing Edit > Preferences > Device Control. 
(Ref# 26824)

• When using an Editing Mode other than Matrox RT.X in Adobe Premiere 
Pro, you won’t be able to use Matrox effects, even though they are listed as 
available in the Effects window. (Ref# 21119)

• If you add a numbered marker to a clip, you’ll see the marker number on the 
clip in the Timeline, but not in the display of the clip in the Monitor window 
or Clip window. (Ref# 18036)

• If you export only audio, you will have to import the resulting .wav file 
manually. (Ref# 29335)

• Windows XP provides the option of formatting your drives using the NTFS 
or FAT32 file system. Your A/V drives must be formatted using NTFS for 
use with Matrox X.tools because NTFS overcomes FAT32 file size 
limitations. When a hard drive is formatted using FAT32, files saved to this 
drive cannot exceed 4 gigabytes in size (approximately 20 minutes of DV 
video). If you do format your hard drive using FAT32, Adobe Premiere Pro 
will freeze if you try to perform an analog capture greater than 4 gigabytes in 
size. (Ref# 27186)

• When performing an .m2v capture of four hours or longer, the associated 
.wav file may be corrupted. This is because the maximum size supported for 
a .wav file is 2 GB. (Ref# 26560)

• If you are using a Matrox dual-head display card, to be able to preview video 
(such as in Premiere Pro’s Monitor window) on your second monitor, you 
must set the resolution and color display settings on your secondary monitor 
to the same as your primary monitor. (Ref# 27042)

• Exporting a clip directly from the Bin will only export the video portion of 
your clip. If you want to export both the audio and video portions of a clip, 
export from the Adobe Premiere Pro Timeline. (Ref# 27449)

• Your video may appear jittery when playing back a segment containing more 
than four single-frame graphics clips from the Premiere Pro Timeline. (Ref# 
28626)

• If you export video to an .m2v file using Matrox Realtime Export to Disk, 
you may see a black line at the top of your video when you play back the file. 
As a workaround, import the .m2v file to the Premiere Pro Timeline, then 
export it again. You can also use Matrox MediaExport to create .m2v files 
because MediaExport uses the Ligos MPEG codec (which is not affected by 
this problem). MediaExport, however, can’t export your video in real time. 
(Ref# 28815)
Operational limitations
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• You may notice flickering on an Adobe Premiere Pro title with rolling 
credits applied. As a workaround, shorten the title on both ends, then 
right-click the title and choose Field Options. In the Field Options dialog 
box, select Flicker Removal. (Ref# 29255)

• Inscriber TitleExpress is not supported for use with Adobe Premiere Pro. 
(Ref# 29612)

• You may receive a message that there is an error in a segment of the Timeline 
if you try to import an Adobe Premiere 6.5 project that contains video 
transitions that are the same length as the clips they are between on the 
Timeline. (Ref# 29375)

• You may not notice a difference in video quality if you change the video 
quality in the Monitor window from Draft Quality to Automatic Quality, 
however, we recommend setting the video quality of your clips to Highest 
Quality. (Ref# 29626)

• Changing the magnification of clips in the Source or Program view of the 
Monitor window is not supported. (Ref# 29461)

• Applying Safe Margins to clips in the Source or Program view of the 
Monitor window is not supported. (Ref# 29511)

• If you play a clip in the Source view of the Monitor window, then 
right-click the Monitor window and choose Display Mode > 
Vectorscope, playback will stop. (Ref# 29669)

• If you import a folder into the Project window, then click the Automate to 
Sequence button with a Matrox video transition selected as your default 
transition, your default transition will be a Cross Dissolve. To set up your 
transition, you’ll have to click the Custom button twice. (Ref# 29428)

• Applying the Hold Filters option to ignore the keyframe settings of a 
freeze-frame effect in Premiere Pro (Clip > Video Options > Frame 
Hold) is not supported. (Ref# 29795 & 29786)

• If you scrub a clip in the Thumbnail viewer of the Project window while it 
is playing, you will not hear the audio portion of your clip. (Ref# 29814)

• If you stop playback of the Timeline with the left or right arrow key, you 
may notice as you move frame-by-frame over the area where two clips meet 
that the position of the current-time indicator is one frame off that of the 
frame displayed in the Monitor window. (Ref# 29724)

• If you choose to export a clip with a Matrox CPU-based effect applied (such 
as a chroma key) to a .tga file, the effect may not display correctly in the 
resulting .tga file. As a workaround, export your clip to a Matrox RT.X 
Single-frame AVI file, then re-import the clip, and export it to a .tga file. 
(Ref# 29831)
rational limitations
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• Matrox RT.X100 Xtreme Pro does not support the voice-over or 5.1 
surround sound functionality of Adobe Premiere Pro. (Ref# 29832)

• If you overlap clips on the Timeline with a Matrox transition between them, 
and apply a negative speed change to one of the clips, you will not hear audio 
when previewing the segment in the Matrox Effect Setup dialog box. As a 
workaround, press the spacebar to render the audio before setting up your 
Matrox transition. (Ref# 29895)

• If you have a nested sequence that contains clips with a Matrox transition, 
Matrox video effects, and negative speed changes applied to it, your video 
transitions and effects may not display correctly when playing back the 
Timeline. (Ref# 29901)

• If you encounter any of the following problems when playing back the 
Timeline, you can clear the Enable Frame Hold option in the Matrox 
Advanced Settings dialog box. For more information, see “Selecting your 
realtime effect settings” in the Matrox RT.X100 Xtreme Pro User Guide 
Supplement.

$ If you apply a Matrox transition to overlapping clips on the Timeline with 
a negative speed change applied to one of the clips, you may experience 
repeated frames when you play back the segment containing the transition. 
(Ref# 29488)

$ If you have a nested sequence that contains a clip with a negative speed 
change applied to it, your nested sequence may not display correctly when 
playing back the Timeline. (Ref# 29578)

$ Playing back a nested sequence containing a segment with a transition may 
result in repeated frames if the original transition has an Alignment of 
Center at Cut or End at Cut. To avoid this problem, use an Alignment 
of Start at Cut. (Ref# 29942)

• If you trim a clip in the Source view of the Monitor window, your changes 
will not appear on your NTSC or PAL video monitor. (Ref# 29624)

• In the Trim window, the Trim Forward and Trim Backward buttons may 
not respond when trimming a clip. As a workaround, trim directly in the 
Trim window first, and then use the Trim Forward and Trim Backward 
buttons. (Ref# 29997)

• If you trim clips directly on the Timeline using the Slip and Slide tools, your 
video may not display certain frames accurately in the Source and Program 
views of the Monitor window. (Ref# 30048)

• If your project contains numerous titles created with Premiere Pro’s Titler, 
you may notice a long delay when importing your project to the Timeline. 
As a workaround, save your titles as .tga files instead of .prtl files. (Ref# 
30026)
Operational limitations
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• The Japanese topic titles do not display correctly in the Contents of the 
Matrox online help for the Japanese RT.X add-on effects. However, the 
topics will display correctly and you can also refer to the Index to locate 
information. (Ref# 29634)

• If you use the sliders to adjust the Warp Shape of your custom Matrox 
mesh warp effect, then select Lock aspect ratio, the sliders may revert to 
the minimum (1) or maximum (32) value available, but will still maintain the 
correct aspect ratio. (Ref# 30910)

• If you import titles created with the original version of Premiere Pro into 
Premiere Pro 2.0, the title may not display correctly. (Ref# 31216)

• If you choose to Report Dropped Frames in the Matrox Advanced 
Settings dialog box, playback of the Timeline may stop after clicking OK to 
the first dropped frames report. (Ref# 31115)

• If you change the center point settings for a realtime Adobe 3D Motion 
Tumble Away transition in the Effect Controls window, the transition will 
require rendering. (Ref# 29956)

• If you apply a Matrox effect to a graphics clip that’s not full-screen (that is, a 
resolution other than 720×480 for an NTSC image, or 720×576 for a PAL 
image), you may notice a degradation in the image quality, and the fields 
may be inverted. (Ref #31778)

• You may experience system instability if you import a file into Premiere Pro 
with a file name that exceeds 130 characters. (Ref# 30292)

• You may have problems playing back the Timeline if you apply negative 
speed changes to a nested sequence that already contains a negative speed 
change. (Ref# 31834)

• Do not choose an Adobe project preset when editing with Matrox X.tools, or 
your final project may not display the correct aspect ratio. If you want to use 
Adobe presets, uninstall Matrox X.tools. (Ref# 31849)

• If you select the Motion effect in the Effect Controls window to directly 
manipulate a clip using handles in the Program view, the clip will appear 
jittery on your NTSC or PAL video monitor if you play the clip with the 
handles still visible in the Program view of the Monitor window. (Ref# 
31882)

• If an Out point of a clip to be captured to MPEG-2 IBP format does not 
match your GOP size, your selected Out point will be appropriately adjusted 
to a later Out point. (Ref# 31863)

• This release of Matrox X.tools does not support capturing clips while you 
perform other tasks in Adobe Premiere Pro. (Ref# 31938)

• Editing in Premiere Pro while the “Updating Timeline” message is displayed 
may cause Premiere Pro to become unresponsive and cause the Updating 
rational limitations
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Timeline dialog box to remain onscreen for an extended period of time. As a 
workaround, wait until the “Updating Timeline” message disappears before 
continuing to edit your project. (Ref# 31936)

• You may notice sluggishness when scrubbing the Premiere Pro Timeline 
over a segment of trimmed clips with Premiere Pro’s Motion effect applied 
to one of the clips. (Ref# 31993)

• If you log a clip to be batch captured, then place the offline clip on the 
Premiere Pro Timeline, the Program view of the Monitor window will still 
display the offline clip even after you capture the clip. To refresh the 
Program view, scrub or play the clip on the Timeline. (Ref# 31974)

• If you offline a clip in the Source view of the Monitor window by choosing 
Project > Make Offline in the Project window, and then select the option 
Media Files Remain On Disk, you will lose the audio portion of the clip if 
you then choose to play the offline clip. (Ref# 32052)

• If you have a clip on the Timeline that has been rendered with default crop 
settings applied, and you change the default crop settings (either by changing 
the crop values or disabling the default cropping), the previously applied 
crop settings are retained on the clip, even after deleting the render files. To 
apply new crop settings to the clip, you have to change the crop settings in 
the Matrox Effect Setup dialog box. (Ref# 32053)

• If you select the Motion effect in the Effect Controls window to directly 
manipulate a clip using handles in the Program view of the Monitor 
window, Premiere Pro will stop responding if you click the Setup button to 
set up your video effect as you play the clip with the handles still visible in 
the Program view. (Ref# 31997)

• If you choose a standard Matrox project preset, select Default scale to 
frame size (Edit > Preferences > General), and import a 16:9 video clip 
into the project, the clip will appear letterboxed and pillarboxed when you 
preview the clip on the Premiere Pro Timeline. If you apply a non-realtime 
effect to the clip, it will be rendered correctly (letterboxed only). (Ref# 
32084)

DV-1394 devices with Adobe Premiere Pro
• For up-to-date information about supported DV-1394 devices, check the 

Matrox RT.X Support section of our web site at www.matrox.com. If your 
DV-1394 device is not supported, you may not be able to accurately use 
device control for batch capture and export to tape. In this case, you can 
manually capture your clips and manually activate DV recording to record 
material onto tape. For other important information about using DV-1394 
devices, see the section titled “Things you need to know about using 
DV-1394 devices” in the “Defining Your Adobe Premiere Settings” chapter 
of your Matrox RT.X100 Xtreme Installation and User Guide.
Operational limitations
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• After completing an export to tape using Matrox DV-1394 device control, 
you’ll get an error message if you immediately try to perform another export 
to tape. To resolve this problem, scrub on the Timeline that you want to 
export before starting the next export to tape. (Ref# 40714)

• When performing a DV-1394 batch capture, you may lose the video display 
in the Capture window. The display will resume at the start of the next clip 
in the batch list. (Ref# 21026)

• When using the Go To time code feature of Adobe Premiere Pro’s Capture 
window, typing a number higher than the last frame on your tape will not cue 
to the end of your tape. (Ref# 17998)

• If Always output to 1394 is already selected when connecting a DV-1394 
device, wait for a sound confirming connection before scrubbing on the 
Timeline. (Ref# 26966)

• If you have the Always output to 1394 option selected, you may encounter 
the following problems: 

$ Premiere Pro may freeze when playing back a complex project. 

$ You may receive an error message stating that your system can’t sustain the 
required data rates when performing a preview or scrub. 

Turning your DV-1394 device off and then back on allows Windows Plug 
and Play to re-detect your device, and normal functionality should be 
restored to Premiere Pro. If you experience this problem repeatedly, clear 
Always output to 1394 in the Matrox Advanced Settings dialog box. 
(Ref# 27377) 

• When performing an export to DV tape, make sure that your DV-1394 device 
is set to use the time code format (drop frame or non-drop frame) that you’ve 
striped on your DV tape. (Ref# 26814)

• In the Matrox DV Export to Tape dialog box, if you click the Browse 
button to add a logo (.tga) to your recording, the name of the .tga file will be 
displayed in the Browse dialog box until you select another .tga file. If you 
want to add the logo (.tga)  to your recording, you must enter a duration. 
(Ref# 26965)

• When performing an export to DV tape in which the audio portion of your 
Timeline is longer than the video portion, the entire audio portion will not be 
exported correctly. As a workaround, use the work area bar to select the 
entire range you want to export, and choose Work Area from the Project list 
in the Matrox DV Export to Tape dialog box. (Ref# 28480)

• When capturing analog video from your DV-1394 device using Matrox 
DV-1394 Device Control, the capture may take longer to start if the device is 
not already playing when you begin the capture. (Ref# 27238)
rational limitations
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• If you perform a realtime export to DV tape using a particular DV-1394 
device, then play back the tape in a different device, the time code may not 
be accurate. (Ref# 27945)

• Your DV tapes must contain continuous and consecutive time code. If you 
have to use a tape that hasn’t been striped to record video, however, continue 
recording for a few seconds after the material you want, then rewind the 
tape, and begin recording again over the material you don’t want to ensure 
that there are no gaps between recorded material. You can also use the 
edit-search function on your DV-1394 device. (Ref# 29026)

• If you choose to capture the 2nd audio stream when performing a DV-1394 
capture in Premiere Pro, the resulting .wav file may be one frame longer or 
shorter than the original clip. As well, the .wav file will not contain any Clip 
Data or Timecode information. (Ref# 29171 & 31971)

• When using Matrox DV-1394 Device Control, the option to Abort capture 
on dropped frames is not available in Premiere Pro’s Capture window. 
(Ref# 29524)

• When using Matrox DV-1394 Device Control, the Slow reverse and Slow 
play buttons in Premiere Pro’s Capture window do not respond. As a 
workaround, use the shortcut keys. To set up your shortcut keys in Premiere 
Pro, choose Edit > Keyboard Customization. (Ref# 23046, 26934, & 
29519)

• When performing a manual capture from your DV-1394 device, make sure 
the device is already playing when you begin the capture, or your captured 
file may be out of sync or contain repeated frames. (Ref# 30049)

• If you press Fast Forward when your DV-1394 device is already playing in 
the Capture window, your device will stop and then fast forward at full 
speed. (Ref# 29996)

• When using Matrox DV-1394 Device Control, if your DV-1394 device 
automatically rewinds once it reaches the end of a tape, Premiere Pro will 
not notify you that your capture has stopped or prompt you to save your clip. 
(Ref# 30094, 30092, & 30091)

• If you have the Always output to 1394 option selected, and create a 
segment of three or more clips with a Matrox chroma key and a Matrox 
advanced DVE applied to each of the clips for the purpose of creating a PiP 
effect, the PiP effect will not display correctly in the Preview window when 
you initially set up your effect in the Matrox Advanced Settings dialog 
box. (Ref# 31182)

• When performing a DV-1394 capture using a Sony DSR-40 DV-1394 device, 
the first frame of your captured clip may contain pixel artifacts. (Ref# 
31984)
Operational limitations
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• When using the Scene Detect feature in Premiere Pro’s Capture window 
on a Matrox RT.X system, Scene Detect is supported only when 
performing a Matrox AVI Capture. (Ref# 31891)

DVD authoring and other third-party programs
• If you want to use Adobe Encore DVD while Premiere Pro is already 

running, you must disable the Matrox WYSIWYG DirectShow Control 
Panel prior to starting Encore DVD. (Ref# 31946)

• If the GOP structure of your video segment is not 15 frames in length when 
performing a Matrox realtime export to disk, Adobe Encore DVD will 
recognize the segment as 15 frames. (Ref# 31949)

• The Edit Original command in Adobe Encore DVD and Adobe After 
Effects is not supported for use with Matrox .avi files. (Ref# 31948)

• If you export a Matrox .m2v file using Matrox Realtime Export to Disk, 
and then import the clip into Adobe Encore DVD (version 1.5 or 2.0), the 
audio portion of your clip may be longer than the video portion. (Ref# 
31486)

• If you are using Adobe Encore DVD in a system with an NVIDIA display 
card installed, make sure to use only the latest display driver available on the 
NVIDIA web site at www.nvidia.com (Ref# 31242)

• Software DVD players (such as CinePlayer) cannot preview your .m2v files 
accurately, so that you may think the .m2v file is not frame-accurate. This 
will not occur once you burn the DVD. (Ref# 27994)

Matrox MediaExport
• If you encode your Windows Media video using a recent Windows Media 

video codec (such as version 9.0), your video may not play back on older 
versions of Windows Media Player (such as version 6.0). (Ref# 28714)

Matrox MediaTools
• Matrox MediaTools doesn’t support scan and capture from an HDV device 

that you’ve set to downconvert HDV to DV. Instead of capturing the clips to 
individual .avi files, all the clips on the tape will be captured to the same .avi 
file. (Ref# 37466)

• The Export to Premiere command is no longer available in Matrox 
MediaTools for exporting clips to an Adobe Premiere project. (Ref# 37175)

• If you perform a capture in MediaTools when your DV-1394 device is 
already playing a tape, the time code display may freeze even though the 
tape is still playing. This does not have any effect on the capture itself. (Ref# 
24718)

• To avoid problems with MediaTools, do not press any of the buttons on your 
DV-1394 device during a scan and capture. (Ref# 28472)
rational limitations
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• On certain DV-1394 devices, you may experience audio sync problems when 
capturing live video in MediaTools. As a workaround, leave a tape in the 
cassette compartment of your DV-1394 device when capturing live video. 
(Ref# 29150)

Matrox WYSIWYG applications
• There may be operational limitations when using the WYSIWYG 

DirectShow Control Panel with certain DirectShow programs. By default, 
the Matrox WYSIWYG DirectShow output to your NTSC or PAL monitor is 
enabled. Some DirectShow applications, however, may not display the video 
properly. If this happens, you can disable the display on your video monitor 
by clicking the Disable button. For details, see the section “Configuring the 
WYSIWYG DirectShow Control Panel” in your Matrox RT.X100 Xtreme 
Pro User Guide Supplement. For more information on supported programs 
and video formats, and a list of programs and video formats we’ve found to 
be unsuitable for use with the WYSIWYG DirectShow Control Panel, see 
the Frequently asked questions (FAQs) in the RT.X Support section of our 
web site at www.matrox.com/video/support.

• If you use the WYSIWYG DirectShow Control Panel to play back DVCPRO 
.avi files, the video may not display correctly with certain DirectShow 
applications, such as Windows Media Player. (Ref# 30883)

• When using the Adobe Photoshop plug-in to display a grayscale image with 
a width dimension smaller than the height, the image may be corrupted when 
displayed on your NTSC or PAL video monitor. For best results, use only 
standard resolutions to display grayscale images, such as 320×240, 
640×480, 720×576, 720×480, 800×600, 1024×768, 1280×1024, or 
1600×1200. Larger images, however, may take longer to display on your 
video monitor. (Ref# 30015 & 31116)

• When using the Matrox WYSIWYG plug-in for Adobe After Effects version 
7.0, the alpha channel will be ignored. If you select the Alpha only option in 
the Matrox Preview Setup dialog box, the preview of the alpha channel 
will be corrupted. Therefore, you’ll only be able to preview your 
composition without the alpha channel (that is, without any keying) on your 
NTSC or PAL monitor. (Ref# 38497)

• You must disable the Matrox WYSIWYG DirectShow Control Panel prior to 
using discreet combustion 3. (Ref# 31628)
Operational limitations
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How to get Matrox RT.X Customer Support
The following sections explain how customers in the U.S. and Canada can obtain 
Matrox RT.X Customer Support.

Register your Matrox RT.X product
To be eligible for customer support, you must register your Matrox RT.X product. 
For more information about becoming a registered user, see the manual for your 
Matrox product or the Matrox Support section of our web site at 
www.matrox.com/video/support.

What kind of support can I expect from Matrox?
You can expect free phone support for up to six months after the purchase of your 
Matrox RT.X product. After the six-month period is up, you will be required to 
pay for phone support for new support issues. If you have an unresolved support 
issue in progress with Matrox Customer Support when the period for which you 
are eligible for free phone support has expired, you will continue to receive free 
phone support for that issue until it is resolved.

¦ Note The Support section of our web site offers up-to-the-minute information 
about Matrox products, and solutions to many common problems. Before calling 
for phone support, you may want to check the information listed on the Support 
section of our web site, such as our User forums, Frequently asked questions 
(FAQs), and System recommendations pages. For more information, see 
www.matrox.com/video/support.

How much does phone support cost and how 
do I pay for it?
You pay for phone support using support tokens. One support token can be 
redeemed for one phone support incident. A single support token costs 
$29.95 US. Support tokens can be purchased through our web site at 
www.matrox.com/video/support, or over the phone with a Matrox customer 
service representative. When you call for phone support you will be asked for 
your Token ID, which will be administered at the time of purchase.

Remarks
• Support tokens can be purchased using credit cards only.

• You are responsible for any phone line charges that may apply to you.

What is a phone support incident?
A phone support incident is a single support issue that cannot be broken down 
into subordinate problems. If a support issue is related to one or more problems, 
each problem will be treated and charged as a separate incident. You and your 
Matrox customer support representative will decipher the nature of the problem, 
and your Matrox representative will let you know if your problem consists of 
 to get Matrox RT.X Customer Support

http://www.matrox.com/video/support
http://www.matrox.com/video/support
http://www.matrox.com/video/support
http://www.matrox.com/video/support
http://www.matrox.com/video/support
http://www.matrox.com/video/support
http://www.matrox.com/video/support


17
more than one incident. Phone support will be provided until your support issue 
is resolved.

What information should I have ready before 
calling Matrox?
Be prepared to have the following information ready before calling a Matrox 
customer service representative for phone support:

• Client ID (provided when you register your Matrox RT.X product).

• Token ID (if applicable).

• Name of your product.

• System information (operating system, motherboard, computer model, etc.)

• Nature of your problem.

¡ Important The Matrox representative may need specific details about your 
system. To facilitate phone support, please make sure you have access to your 
system when you call. 

Contact info
The following numbers are subject to change. For up-to-date contact information, 
always check our web site at www.matrox.com/video/support.

• If you are eligible for free phone support for your RT.X product, please call 
1-514-822-6030.

• For token-based phone support, please call 1-866-443-5052.

¡ Important Your client ID and/or customer profile will be validated to 
determine your eligibility for free phone support.
How to get Matrox RT.X Customer Support
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